
 

 

 

 

 

 

Commitments of Traders Index-01.ex4 
Commitments of Traders Net Positions-01.ex4 
Commitments of Traders Open Interest-01.ex4 
User Guide  
Installation Guide 
Version 1.4 
 
January 2008 
© Copyright www.COT4MetaTrader.com, 2006, 2008 



Commitments of Traders suite from 
www.COT4metaTrader.com 

Page 2 of 22 

 

Disclaimer 
 
The products referenced in this document an provided on 
www.COT4Metatrader.com are analytical tools only, and are not intended to 
replace individual research or licensed investment advice. Unique experiences 
and past performance do not guarantee future results. 

Trading currencies involves substantial risk, and there is always the potential for 
loss. Your trading results may vary. No representation is being made that these 
products, and any associated advice or training, will guarantee profits, or not 
result in losses from trading. Neither the products, any explanation or 
demonstration of their operation should be construed as providing a trade 
recommendation or the giving of investment advice. The purchase, sale or advice 
regarding a currency can only be performed by a licensed Broker/Dealer. Neither 
www.COT4Metatrader.com , nor any of my affiliates or associates involved in the 
in the production and maintenance of these products or this site, is a registered 
Broker/Dealer or Investment Advisor in any State or Federally-sanctioned 
jurisdiction. All purchasers of products referenced at this site are encouraged to 
consult with a licensed representative of their choice regarding any particular 
trade or trading strategy. 
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Quick Installation 
 
1. Copy the following files into your broker’s \experts\indicators directory  
 
Commitments of Traders Index-01.ex4  
Commitments of Traders Net Positions-01.ex4  
Commitments of Traders Open Interest-01.ex4  
 
2. Copy the COT4metatrader.bin file into your broker’s \experts\files directory.  
 
3. Restart your trading platform.  
 
4. Drag and drop the indicator from the Metatrader navigator window on to your 
chart.  
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Introduction 
 
Commitments of Traders Index-01.ex4  
Commitments of Traders Net Positions-01.ex4  
Commitments of Traders Open Interest-01.ex4  
 
displays Commitments of Traders data on the MetaTrader 4 platform.   
 
The following example is the British Pound data shown on a weekly chart 

 
 
The indicators display data regarding the commercial, non-commercial 
(sometimes referred to as speculators) and non-reportable (sometimes referred 
to as small) positions. 
 
On the above chart, the Index indicator is shown twice, showing both the futures 
positions on the GB Pound and the positions of traders on the US Dollar, both as 
an Index.  
 
Three indicators are provided:  
 

Commitments of Traders Index-01.ex4  

The Index indictor displays the net positions as an Index from 0 to 100.  ) 
represents the time when traders were most short and 100 represents the time 
when traders were most long.  
 
This indicator also shows an index of the total number of open positions.  
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Commitments of Traders Net Positions-01.ex4  

The Net Positions Indicator shows the actual number of net positions and the 
scale varies depending upon the highest and lowest.  The Net position will be 
negative when the traders have more short positions than long positions.  

Commitments of Traders Open Interest-01.ex4  

Finally, the third indicator shows the Open Interest for both Long and Short 
positions for each of the three types of trading groups.  
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General Features 

 
These Indicators provide the following features:   

• Commercial Interest 

• Non-Commercial (or speculative) interest 

• Non-reportable (or small trader) interest 

• Open Interest  

• Works on all timeframes up to and including weekly 

• Shows the futures positions for the following currencies on the indicated 
charts  

o GB Pound (GBPUSD) 
o Euro (EURUSD) 
o Australian Dollar (AUDUSD) 
o Swiss Franc (USDCHF) 
o Japanese Yen (USDJPY) 
o Canadian Dollar (USDCAD) 
o Mexican Peso (USDMXN) 

• Shows the futures positions for the US Dollar on any USDxxx or xxxUSD 
chart.  

• Can be used within your own Custom Indicators or within Expert Advisors 
to develop automated trading strategies.  

• Historic COT data is provided from August 2004 to present time. 
 
As well as displaying the data on the chart, if you open the Data window (Ctrl-D) 
in MetaTrader, you will see the values of the data displayed clearly.  The 
following example is for the Commitments of Traders Index-01 indicator.  
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Installation from ZIP file 
1. Download the COT4MetaTrader.zip file  from www.cot4metatrader.com.  

Follow the Downloads link.  
2. Unzip the files to the following locations using your favourite zip program 

(such as Winzip available from www.winzip.com) 
 

File Location 
Commitments of Traders Index-01.ex4  
Commitments of Traders Net Positions-01.ex4  
Commitments of Traders Open Interest-01.ex4 

C:\Program Files\<broker>\experts\indicators 
 
For example:  
C:\Program Files\Interbank FX Trader 
4\experts\indicators 

COT4MetaTrader.bin 
 
Note that if you are a subscriber to the data feed, then 
use the latest file emailed to you. Do not use the sample 
from the website.  

C:\Program Files\<broker>\experts\files 
 
For example: 
C:\Program Files\Interbank FX Trader 
4\experts\files 
 

 
Substitute <broker> for the location where you installed your broker’s 
platform.  The example given is the default location for InterBank FX.  If you 
use a different broker or installed the application into another location, you 
must substitute the location where the brokers platform is installed. Contact 
your broker for assistance.  

 
3. Stop and restart your MetaTrader4 platform.  

 
4. Installation is complete.  
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Installation from separate files 
1. Download each of the following files from www.cot4metatrader.com.  

Follow the Downloads link.  
 
If using Internet Explorer, right click on each file on our download page 
and select the “Save Target As” option.  
 
IF using Mozilla’s Firefox, right click on each file on our download page 
and select the “Save File As” option.  

 
 

File Location 
Commitments of Traders Index-01.ex4  
Commitments of Traders Net Positions-01.ex4  
Commitments of Traders Open Interest-01.ex4 

C:\Program Files\<broker>\experts\indicators 
 
For example:  
C:\Program Files\Interbank FX Trader 
4\experts\indicators 

COT4Metatrader.bin 
 

Note that if you are a subscriber to the data feed, then use 
the latest file emailed to you. Do not use the sample from 
the website. 

C:\Program Files\<broker>\experts\files 
 
For example: 
C:\Program Files\Interbank FX Trader 
4\experts\files 

 
Substitute <broker> for the location where you installed your broker’s 
platform.  The example given is the default location for InterBank FX.  If you 
use a different broker or installed the application into another location, you 
must substitute the location where the broker’s platform is installed.  Contact 
your broker for assistance.  
 

 
2. Stop and restart your MetaTrader4 platform.  

 
3. Installation is complete 
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Upgrading from an earlier version  
 

If you are installing COT4metaTrader for the first time then you can ignore 
this section.  
 
If you are upgrading then please remove the following files from your system:  
 
 

File Location 
Commitments of Traders-01.ex4  
Commitments of Traders-01.mq4  
Commitments of Traders-02.ex4  
Commitments of Traders-02.mq4 

C:\Program Files\<broker>\experts\indicators 
 
For example:  
C:\Program Files\Interbank FX Trader 
4\experts\indicators 

COT.csv C:\Program Files\<broker>\experts\files 
 
For example: 
C:\Program Files\Interbank FX Trader 
4\experts\files 

 
Substitute <broker> for the location where you installed your broker’s 
platform.  The example given is the default location for InterBank FX.  If you 
use a different broker or installed the application into another location, you 
must substitute the location where the broker’s platform is installed.  Contact 
your broker for assistance.  
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Using the Commitments of Traders Indicators 
 

1. Open a chart for one of the following currencies:  

a. GBPUSD  
b. EURUSD  
c. AUDUSD  
d. USDCHF  
e. USDJPY  
f. USDCAD  
g. USDMXN  

 
Note that if the currency pair is not supported on your broker then 
you can not use the Commitment of Traders-02.mq4 program on 
that currency pair.  
 
 

2. Select Timeframe to be weekly by pushing the W1 button on the toolbar. 
 

 
 

3. Open the Navigator by pressing Ctrl-N or selecting the Navigator option off 
the View menu: 
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4. Click on the + next to the Custom Indicators to expand the list of available 
Custom Indicators: 
 

 
 

5. Look for the Commitments of Traders indicator that you wish to apply to 
your chart (highlighted above) and drag and drop it onto your open chart.  
 
Note that although this is possible to do, we strongly recommend that you 
do not put more than one Commitments of Traders indicator in the same 
indicator window.  It looks rather busy and can be misleading.  Place them 
in separate indicator windows.  You do this by dragging the indicator onto 
the price window – not onto an existing indicator window. 

 
 
6. If you want to show both USD index and the specific currency index then 

you will need to add the indicator to the chart twice.   
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Use the ShowUSD option set to true to display the USD index.  Set it to 
false to show the other currency of the USDxxx/xxxUSD currency pair. 
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Configuring Commitments of Traders Index-01 
 

When you place the indicator on your chart, you are presented with options:  

 

ShowCommercial – true or false 

True shows the index of commercial positions.  Commerical positions are 
sometimes referred to as “The Big Dogs”. 

False do not show the index of commercial positions.  

By default the commercial index is shown as a red line. 

ShowNonCommercial – true or false 

True shows the index of non-commercial positions.  Non-Commerical 
positions are sometimes referred to as “speculators”. 

False do not show the index of non-commercial positions.  

By default the non-commercial index is shown as a Green line.  

ShowNonReportable – true or false 

True shows the index of non-reportable positions.  Non-reportable 
positions are sometimes referred to as “small”. 

False do not show the index of non-reportable positions.  

By default the non-reportable index is shown as a Blue line. 
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ShowOpenInterest – true or false 

True shows the Total Open Interest. Open Interest is the total volume of 
open futures contracts.  

False do not show the index of Open Interest.  

By default the commercial positions are show as a Black line. 

ShowUSD – true or false 

True shows the futures positions for the US Dollar positions.  When you 
specify true,this indicator will only work on a currency pair containing the 
USD, i.e. USDxxx or xxxUSD.  

False do not show the index of US Dollar positions.  When you specify 
False, this indicator will only work on the following currency pairs: 

a. GBPUSD  
b. EURUSD  
c. AUDUSD  
d. USDCHF  
e. USDJPY  
f. USDCAD  
g. USDMXN 

Filename 

Enter the file name of the COT file. This is distributed as 
COT4Metatrader.bin.  If you rename the file (not recommended) then you 
must change this value.  

 

Colors and line styles 

To change the colors, line styles or widths, when you add the Commitments of 
Traders Index-01 indicator to your charts, click on the Colors tab: 
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• 0 – Black – Open Interest 

• 1 – Red – Commercial 

• 2 – Green – Non-Commercial 

• 3 – Blue – Non-reportable 
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Configuring Commitments of Traders Net Positions-01 
 

When you place the indicator on your chart, you are presented with options:  

 

ShowCommercial – true or false 

True shows the net positions of commercial traders.  Commerical 
positions are sometimes referred to as “The Big Dogs”. 

False do not show the net positions of commercial traders.  

By default the commercial positions are show as a red line. 

ShowNonCommercial – true or false 

True shows the net positions of non-commercial traders.  Non-
Commerical positions are sometimes referred to as “speculators”. 

False do not show the net positions of non-commercial traders.  

By default the non-commercial positions are show as a Green line.  

ShowNonReportable – true or false 

True shows thenet positions of non-reportable traders.  Non-reportable 
positions are sometimes referred to as “small”. 

False do not show the net positions of non-reportable traders.  

By default the non-reportable positions are show as a Blue line. 
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ShowUSD – true or false 

True shows the futures positions for the US Dollar positions.  When you 
specify true,this indicator will only work on a currency pair containing the 
USD, i.e. USDxxx or xxxUSD.  

False do not show the index of US Dollar positions.  When you specify 
False, this indicator will only work on the following currency pairs: 

h. GBPUSD  
i. EURUSD  
j. AUDUSD  
k. USDCHF  
l. USDJPY  
m. USDCAD  
n. USDMXN 

Filename 

Enter the file name of the COT file. This is distributed as 
COT4Metatrader.bin.  If you rename the file (not recommended) then you 
must change this value.  

 

Colors and line styles 

To change the colors, line styles or widths, when you add the Commitments of 
Traders Index-01 indicator to your charts, click on the Colors tab: 
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• 0 – Red – Commercial 

• 1 – Green – Non-Commercial 

• 2 – Blue – Non-reportable 
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Configuring Commitments of Open Interest-01 
 

When you place the indicator on your chart, you are presented with options:  

 

ShowCommercial – true or false 

True shows the long and short Open Interest of commercial traders.  
Commerical traders are sometimes referred to as “The Big Dogs”. 

False do not show the Open Interest of commercial traders.  

By default the commercial Open Interest is shown as a red line. Solid for 
the Long positions and Dotted for the Short. 

ShowNonCommercial – true or false 

True shows the the long and short Open Interest of non-commercial 
traders.  Non-Commerical traders are sometimes referred to as 
“speculators”. 

False do not show the Open Interest of non-commercial traders.  

By default the non-commercial Open Interest is shown as a Green line. 
Solid for the Long positions and Dotted for the Short. 

 

ShowNonReportable – true or false 
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True shows the long and short Open Interest of non-reportable positions.  
Non-reportable traders are sometimes referred to as “small”. 

False do not show the Open Interest of non-reportable traders.  

By default the non-reportable Open Interest is shown as a Blue line. Solid 
for the Long positions and Dotted for the Short. 

ShowUSD – true or false 

True shows the futures positions for the US Dollar positions.  When you 
specify true,this indicator will only work on a currency pair containing the 
USD, i.e. USDxxx or xxxUSD.  

False do not show the index of US Dollar positions.  When you specify 
False, this indicator will only work on the following currency pairs: 

o. GBPUSD  
p. EURUSD  
q. AUDUSD  
r. USDCHF  
s. USDJPY  
t. USDCAD  
u. USDMXN 

Filename 

Enter the file name of the COT file. This is distributed as 
COT4Metatrader.bin.  If you rename the file (not recommended) then you 
must change this value.  

Colors and line styles 

To change the colors, line styles or widths, when you add the Commitments of 
Traders Open Interest-01 indicator to your charts, click on the Colors tab: 
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• 0 – Red Solid – Commercial Long 

• 1 – Red Dot – Commercial Short 

• 2 – Green Solid – Non-Commercial Long 

• 3 – Green Dot – Non-Commercial Short 

• 4 – Blue Solid – Non-reportable Long 

• 5 – Blue Dot – Non-reportable Short 
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Refreshing the COT data 
 

If you subscribe to the COT4MetaTrader.com data feed then you will receive a 
replacement COT4metaTrader.bin file each week.  
 
1. Using your email client, detach the attached file called COT4metaTrader.bin and 
save it in the following location 
 
 
C:\Program Files\<broker>\experts\files 

 
Substitute <broker> for the location where you installed your broker’s platform.  The 
example given is the default location for InterBank FX.  If you use a different broker or 
installed the application into another location, you must substitute the location where the 
broker’s platform is installed.  Contact your broker for assistance. 
 
If prompted you must replace the existing file with the new file you are receiving.  
 
2. Stop and restart your MetaTrader 4 platform.  
 
 


